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This is the help-file for FontLister. It's no very big, because I've put all the help into the control. You can get help on 
almost any controls. If there's a  (question mark) in the upper-right window, click it followed by the control. If there's
no question-mark, press F1 while the control is active (has focus).



Getting started with FontLister

When you start up FontLister, you'll see the main-screen with a listview of all your fonts (located to the left), and a 
text-area located to the right. By clicking on one of the fonts in the list, you'll notice that the text-area immediately 
changes its font to the selected one. Click somewhere in the text-area, and you can write your own text (or copy 
some text from another program using standard Ctrl-C / Ctrl-V shortcuts).

Try selecting several fonts from the list by holding down Ctrl or Shift while left-clicking in the list. Now change the 
view-mode by clicking on the  (compare) button located in the top toolbar. You will get a list of all the selected fonts.
From this list, you can deselect some of them by right-clicking the font and choose "Unselect font" from the popup-
menu. Again, you can use Ctrl/Shift to select multiple items.

 



Feedback

If you're having troubles running FontLister, try to check my FAQ-page on the .net. This page is regularly updated with
new Question and Answers.

FontLister FAQ-page:
    http://www.conquerware.dk/flfaq.htm

If you can't find any help on this page, you're welcome to write me an email. Please check Contact Information for 
addresses.



Help for all controls

You can get help on almost any controls in FontLister. If there's a question-mark in the upper-right window, click it 
followed by the control you want the help for. If there's no question-mark, you simply press F1 while the control is 
active (has the focus).



How do I register FontLister?

It's quite easy to register your own copy of FontLister; and it's only $5. Visit the FontLister homepage (see URL 
below) and select 'order copy' from the menu. It's possible to pay using all major credit cards (VISA, MasterCard, etc).

If you don't fell safe to pay using your credit card, you can mail me a $5 bill. Please be sure to include your name and
your email address in your letter.

Mailing address:
    ConquerWare
    Attn: Peter Theill
    Kalundborgvej 173
    4300 Holbaek
    Denmark

FontLister page on the .net
    http://www.conquerware.dk/fl.htm

Email Address
    peter@conquerware.dk



Contact Information

FontLister page on the .net
    http://www.conquerware.dk/fl.htm

Email Address
    peter@conquerware.dk

Mailing address:
    ConquerWare
    Attn: Peter Theill
    Kalundborgvej 173
    4300 Holbaek
    Denmark



Toolbars

For faster access to frequently used commands, FontLister uses toolbars. One for operations like font installation, 
font removal, mode change etc. and another one for text operations like changing font size, sample text and -style.

Click on a toolbar for more information about it.

Operations Toolbar

Text Toolbar



Operations Toolbar

The following is a description of all buttons on this toolbar, starting from left.

Refresh
Refresh all visible windows and current font selection. If you view seems wierd, try to click this button.

Print Preview
Shows a Preview using current settings. This enables you to get a overview of, how you fonts will be printed on paper
before actually using any.

Print
Prints your fonts using current settings. If you want to change these settings expand the File menu and select 
Print...

Edit mode
Changes current mode to Edit. When you're in Edit mode, you're able to change e.g. the sample text used in 
Compare mode. It's simply the first line in the text-box.

Compare mode
Changes current mode to Compare. In Compare mode, you'll see a list of all selected fonts. If you want to compare 
e.g. Verdana and Helvetica, select these two from the fontlist and a sample of them will be shown in the right side of 
the window.

ANSI Table
Opens an ANSI table showing the current font. It's possible to change font while the ANSI table is shown.

Font Properties
Shows a lot of extended information about selected font, e.g. height, weight, type, family, charset, styles, scripts, etc.

Install Font
Installs all selected fonts onto your system. This button is only available if you're viewing uninstalled fonts (View-
>Fonts an a Folder).

Remove Font
Removes all selected fonts from your system. this button is only available if you're viewing Installed fonts (View-
>Installed fonts).

Change view
Enables you to change view quickly. Press the down-arrow and select one of the view-modes.



Text Toolbar

The following is a description of all buttons on the toolbar, starting from left.

Font Size
Changes size of sample text. Click on the down-arrow and select a standard fontsize or write your own size directly 
into this combo-box.

Text Sample
Selects a sample, i.e. no sample, default sample or all ANSI characters.

Bold
Makes the font bold.

Italic
Makes the font italic.

Underline
Makes the font underlined.



Legends

Indicates a TrueType (*.ttf) font .
Indicates a TrueType (*.ttf) font already installed on your system. This icon is only available when viewing 

Fonts in a Folder (uninstalled fonts).
Indicates a Raster font.
Indicates an Adobe Type 1 Font.



Left-click on a font to view it in the window to the right. If you want to view multiple fonts, click on  (the "Compare Mode"-button) 
located above this listbox. If you right-click in this listbox, a popup-menu appears. Now you can select "Font Info" if you want to view 
extended font-information for a specific font, "Install font" or "Delete font" if you want to either install or delete a font to/from your 
system. One of these options is always grayed, because you can't install a font, if it's already installed and you can't delete a font if 
you view it uninstalled. You can also choose to print fonts by selecting the "Print font"-menu item.



Choose what kind of font you want to view. Select "Screen fonts" if you want to view the fonts supported by your system (normally 
all available). Select "Printer fonts" if you want to view fonts supported by your printer (this is normally all fonts because Windows 
GUI simulated TrueType-fonts like graphics). Select "Uninstalled fonts" if you want to view some fonts from a CD-ROM or in a 
specific directory on your harddrive, without installing them first.



Change the current font-size. If you want to view your fonts with a larger size, click in the box and select ex. 36 points. Immediately 
the text-window will be updated with the selected size. If you've selected the "Compare-mode" you should consider using a mediate 
size for better font-browsing. You don't have to use the predefined numbers. If you want to set your fontsize to 51, just type it in the 
box.



Write your own text in this window. All the normal editor-tricks works, like Ctrl-C for copying text to the clipboard, Ctrl-V paste the text
from the clipboard and Ctrl-A if you want to select all the text. You can also right-click in the window and select the functions from the
popup-menu.
    If you want to use your own text in the window, click on the File-menu and select "Import Text" (or press Ctrl-M). You can now 
select the text-file (*.txt) you want to use. Another dialog will appear, asking you, if you want to use the selected file as standard. If 
you choose "Yes", this text will always be used instead of the default three-lined "abdABC123".
    Notice: The first line in this window will be used as the sample-text in Compare mode.



Click the names in the left window to select which fonts to view. If you want to adjust the width of the columns, you can drag the 
rows above. If you right-click in this window, you can unselect a font you don't want to have in the list.
Notice: You can change the used sample-text, by changing the first line in the text-window.



Shows the name of all TrueType fonts in the selected directory. If the text "No fonts found." is shown, the current directory has no 
TrueType fonts and you cannot click on the OK button.
If you can't view all fonts in the list, click the scroll-bar to the right to scroll down.



Close this window and view the fonts in the selected directory. This button can only be clicked if there's fonts in the 
selected directory.



Closes window without viewing uninstalled fonts.



Retrieve the fontnames from the fonts in the selected directory.



Check to automatically retrieve fontnames from the directories you browse. If you uncheck this, you will have to 
click on Refresh before you can view the fonts.



Select which directory you want to search.



Select which drive holds the fonts you want to view.



The text or field in this box, will be printed in the upper left on every page.



The text or field in this box, will be printed in the upper center on every page.



The text or field in this box, will be printed in the upper right on every page.



The text or field in this box, will be printed in the lower left on every page.



The text or field in this box, will be printed in the lower center on every page.



The text or field in this box, will be printed in the lower right on every page.



Select a header or footer-box (e.g. header-left) and click on one of these symbols:

    Insert current pagenumber on every page.

    Insert date on every page.

    Insert time on every page.



Select which font to use in the header.



Select which font to use in the footer.



Currently selected header font. If you want to change this font, click Header Font button.



Currently selected footer font. If you want to change this font, click Footer Font button.



Accept any changes made and return to main window.



Close window and discard any changes made.



When this box is checked, FontLister will automatically update the view when you pick another font.



If you always want to have this window in top of all others, you should check this box.



Closes window.



This is the ANSI table (characters from 0-255) for the selected font.



Select what to print by clicking on one of these radio-buttons.
    · Print selected font(s) prints the fonts you have selected in the font-list.
    · Print text-window prints the text-window using the selected font (or last font selected if multiple).
    · Print all fonts prints all the fonts.



Select how many lines to print with every font.
    · One line prints only the first line in the text-window.
    · Three lines prints the first three lines in the text-window.
    · Text-window prints all the text in the text-window with each font selected.
    · Windows 95 sample prints the sample there's included with Windows 95. This option print a page for every 
font. Notice that you'll have to click OK when the print-dialogs appear.



Print the font(s) using selected options.



Cancel print.



Open Print-Setup to change printer, paper-size, orientation, etc.



Open Paper Setup to modify headers and footers, gap between fontname and sample, and size of sampletext.



This button opens the Page Setup Dialog where you're able to change e.g. margins of page.



This button opens the Printer Setup Dialog where you'll able to change default printed, DPI, orientation, etc.



This is a preview of the currently selected print-method and -option.



Choose which font to use when printing name of font. This box shows the fontname rendered using the font itself. This makes it 
easier to pick a readable font.



Choose which size to use when printing the font-name.



You can't change this because the sample font always is the font currently printing.



The position of the splitter. It's the gap between the font-name and the font-sample.



Minimum value for splitter line.



Maximum value for splitter line.



Choose which size to use when printing font-sample.



Cancel printing.



Small hints will popup in this statusbar. On the right side, you'll sometimes see a progressbar. It's visible when 
FontLister is working on larger jobs.



Description of font information is visible in this field. Move your mouse over a label to read a description.



This statusbar is split in three. The first part shows small hints when your mouse is above a clickable control. The 
second part shows the ANSI code for the selected character. The third part shows the character rendered in a 
normal MS Sans Serif font.



Shows small hints when your mouse is located above a clickable control. When you install and uninstall fonts, a 
progressbar become visible in the right side.



This is the available print methods. When you click on one of them some information about the method will be shown below.



Closes the dialog box and saves any changes you have made.



This is all available scripts for the selected font



If 'Selected fonts' is checked, only selected fonts from the listview will be printed.



This is all available styles for the selected font



When 'All fonts' is selected, all available fonts will be printed.



Shows a preview of how the fonts will be printed using current method, range, etc.



Print using current selection.



This is some information about the selected print method. Select methods by clicking on one of the above layouts.



If you only want to print the fonts you have selected in the listview, check the Selected fonts item. One the other hand, if you want 
to print all available fonts in the listview, you should check the All fonts item.



Print Settings Dialog
File -> Print... (Ctrl+P)

This dialog enables you to change various settings for the layout of printer sheets. To print right away using current 
settings, click Print. If you change a setting or just want to see a preview before printing on the Printer, click Preview.
When you have changed some settings you want to use next time, but don't want to make a print now, click OK. This 
button closes dialog and save changes. Cancel all changes made by clicking Cancel.

Layout
The Layout tab controls which sheets to print and how many of your fonts to print.

In the Method groupbox you're able to change a sheet by left-clicking on the appropriate sheet. There's currently 
three different sheets:

 Single Line Method
This method prints only a single sample line of each font. You usually uses this method if you have a lot of fonts 
and don't want to give up a rain forest 'just' to see a complete sample of all your fonts.

 Multiple Lines Method
This method prints multiple lines of each font. It uses the lines from the 'EditMode' memobox. As default, FontLister
uses a three line 'abc, ABC, 123' sample in this memobox, resulting in a three line print method.

 ANSI Table Method
This method prints all ANSI characters (characters from 32 to 255) of each font. Some of the printed characters 
may not be visible on a keyboard and you'll then have to use the 'ALT+XXX' string FontLister shows on the print 
sheets. Do use this code, press and hold down ALT while tapping in the numbers in the 'Numeric keyboard' 
(numbers to the right of the standard buttons).

In the Range groupbox you're able to change how many fonts you wants to print. Use the selected fonts option if you 
only want to print fonts you select from the font listview located in the main window. If you rather want to print all your 
fonts every time, use the    All fonts option. FontLister will then print all fonts regardless how many fonts you've 
selected in the font listview.

Click Page Setup to change paper margins, orientation and/or paperformat.

Click Printer Setup to change which Printer to print on.

Name and Sample
The Name and Sample tab enables you to change fontname and fontsize of the Sample.

Every time FontLister prints a font, it shows the name of the font in a 100% readable font. You're able to change this 
font by clicking the Name of font combobox and selecting a new font. Notice that every font's name is rendered 
using the font itself. This is done to avoid selecting a unreadable font which would be pointless. You're able to change
fontsizes too, by choosing a value from the Size combobox. A default value is around 6.

To change fontsize of sample, you'll have to use the Sample Size combobox below. A default value is around four 
times Name Size, ie. 24. To use less paper change this value to a lesser value.

Header and Footer
The Header and Footer tab enables you to change the text on top (header) and buttom (footer) of each printed page. 

There is three editboxes for each Header and Footer. The first is left aligned, second is center aligned and the third is 
right aligned. Enter another text string in any of these by selecting them (click them) and type in the text. The gray 
editbox above shows which font to use as Header/Footer. To change this, click the Header Font or Footer Font button
and choose another font from this popup font dialog. By clicking the down arrow further to the right, you're able to 
change to some standard fonts. If you want to use same font for both header and footer, use the Same as 
(header/footer) Font menu item.

Some Field Codes are supported as well, three to be exact. These are:



  Page Number
        Inserts current number of page.

  Date Printed
        Inserts current date using local date format.

  Time Printed
        Inserts current time using local time format.

To insert a field code, you will have to select one of the six Header or Footer editboxes.



Font Properties
View -> Font Properties... (F4)

The Font Properties windows shows extended information about fonts.

There's three different tabs in the Font Properties window (General, Details and Names), but only the first two 
(General and Details) are available when using Screen Fonts ViewType or Printer Fonts ViewType since it's not 
possible to read Name-information from these fonts.

General
The General tab contains information you mostly would like to know about a font. This is: Full Name, Font Family, 
Filename, Folder, Size, Pitch, Family, Font Type, Scripts, Styles and if the font's installed.

 Full Name
This is usually a concatenation of the Font Family and the style, e.g. Arial with a style of Bold Italic would typically 
have Arial Bold Italic as it's full name.

 Font Family
The Font Family shows which family the font belongs to, e.g. Arial Bold, Arial Bold Italic and Arial Italic would all 
belong to the Arial Font Family.

 Folder (only visible when ViewType is Fonts in a Folder or Installed)
This is the path to the physical font.

 Size (only visible when ViewType is Fonts in a Folder or Installed)
This is the size (in kilobyte) of the physical font.

 Pitch
A font can either be a fixed pitch (or monospaced) or variable pitch (proportional). A fixed pitch font use the same 
amount of space for every characters, ie. the width of the letter "i" is equal the the width of the letter "w". A 
typewriter font are usually using this pitch. In a variable pitch font every characters has it's own breadth, thus the 
distance between two letters is various. Most text in books and newspapers are written using a variable pitch font 
(e.g. Arial, Times New Roman and Tahoma).

 Family
Font families describe the look of a font in a general way. The values for families are as follows: 

Decorative Novelty fonts. Old English is an example.
Don't Care Don't care or don't know.
Modern Fonts with constant stroke width (monospace), with or without serifs. Monospace fonts are usually 

modern. Pica, Elite, and CourierNew® are examples.
Roman Fonts with variable stroke width (proportional) and with serifs. MS® Serif is an example.
Script Fonts designed to look like handwriting. Script and Cursive are examples.
Swiss Fonts with variable stroke width (proportional) and without serifs. MS® Sans Serif is an example.

 Font Type
Specifies the type of the font. The values for font types are as follows:

TrueType Indicates a TrueType font (e.g. 'Arial' and 'Times New Roman')
Raster Indicates a Raster font (e.g. 'Courier' and 'System)
Vector Indicates a Vector font (e.g. 'Myriad Roman' and 'Lithos')

 Scripts
Specifies the supported scripts of the font. For example, "Cyrillic".

 Styles
Specifies the styles of the font. For example, "Bold Italic".

 Font Installed
This combobox is checked if the font is installed (available for use) on the system.



Details
The Details tab contains more detailed information about the font. The following in a description of all the different 
attributes.

 Height
Specifies the height (ascent + descent) of characters. 

 Ascent
Specifies the ascent (units above the base line) of characters. 

 Descent
Specifies the descent (units below the base line) of characters. 

 Internal Leading
Specifies the amount of leading (space) inside the bounds set by the tmHeight member. Accent marks and other 
diacritical characters may occur in this area. The designer may set this member to zero. 

 External Leading
Specifies the amount of extra leading (space) that the application adds between rows. Since this area is outside 
the font, it contains no marks and is not altered by text output calls in either OPAQUE or TRANSPARENT mode. 
The designer may set this member to zero. 

 Average Char Width
Specifies the average width of characters in the font (generally defined as the width of the letter x). This value 
does not include overhang required for bold or italic characters. 

 Max. Char Width
Specifies the width of the widest character in the font. 

 Weight
Specifies the weight of the font. 

 Overhang
Specifies the extra width per string that may be added to some synthesized fonts. When synthesizing some 
attributes, such as bold or italic, graphics device interface (GDI) or a device may have to add width to a string on 
both a per-character and per-string basis. For example, GDI makes a string bold by expanding the spacing of 
each character and overstriking by an offset value; it italicizes a font by shearing the string. In either case, there is 
an overhang past the basic string. For bold strings, the overhang is the distance by which the overstrike is offset. 
For italic strings, the overhang is the amount the top of the font is sheared past the bottom of the font. 

 Horizontal Aspect (Digitized Aspect X)
Specifies the horizontal aspect of the device for which the font was designed. 

 Vertical Aspect (Digitized Aspect Y)
Specifies the vertical aspect of the device for which the font was designed. The ratio of the tmDigitizedAspectX 
and tmDigitizedAspectY members is the aspect ratio of the device for which the font was designed. 

 First Character
Specifies the value of the first character defined in the font. 

 Last Character
Specifies the value of the last character defined in the font. 

 Default Character
Specifies the value of the character to be substituted for characters that are not in the font. 

 Break Character
Specifies the value of the character to be used to define word breaks for text justification. 

 Size EM
Specifies the size of the em square for the font. This value is in "notional units" (that is, the units for which the font 
was designed). 



 CellHeight
Specifies the height, in notional units, of the font. This value should be compared with the value of the ntmSizeEM 
member. 

 Avg. Width
Specifies the average width of characters in the font, in notional units. This value should be compared with the 
value of the ntmSizeEM member.

Names
The Names tab contains information about the font and it's names, e.g. Font Family and copyright notice. These 
information are read from the physical font file and is thus only available when current ViewType is Fonts in a Folder 
or Installed Fonts.

 Font Name
Displays the name of the font, including specific attributes, such as italic or bold.

 Font Family Name
Displays the name of the font family to which this font belongs.

 Version
Displays the version number of the font.

 Copyright
Displays the font's copyright information as included by the font manufacturer. Do not assume that missing 
copyright information indicates a public domain font, as it is not uncommon for hackers and font-pirates to remove 
the copyright information contained in commercial fonts.

 Trademark
Displays the font's trademark information set by the font manufacturer.



Specifies the supported scripts of the font. For example, "Cyrillic".



Specifies the styles of the font. For example, "Bold Italic".



This combobox is checked if the font is installed (available for use) on the system.



This list contains detailed information about the font. The following in a description of all the different attributes.

 Height
Specifies the height (ascent + descent) of characters. 

 Ascent
Specifies the ascent (units above the base line) of characters. 

 Descent
Specifies the descent (units below the base line) of characters. 

 Internal Leading
Specifies the amount of leading (space) inside the bounds set by the tmHeight member. Accent marks and other diacritical 
characters may occur in this area. The designer may set this member to zero. 

 External Leading
Specifies the amount of extra leading (space) that the application adds between rows. Since this area is outside the font, it 
contains no marks and is not altered by text output calls in either OPAQUE or TRANSPARENT mode. The designer may set this 
member to zero. 

 Average Char Width
Specifies the average width of characters in the font (generally defined as the width of the letter x). This value does not include 
overhang required for bold or italic characters. 

 Max. Char Width
Specifies the width of the widest character in the font. 

 Weight
Specifies the weight of the font. 

 Overhang
Specifies the extra width per string that may be added to some synthesized fonts. When synthesizing some attributes, such as 
bold or italic, graphics device interface (GDI) or a device may have to add width to a string on both a per-character and per-
string basis. For example, GDI makes a string bold by expanding the spacing of each character and overstriking by an offset 
value; it italicizes a font by shearing the string. In either case, there is an overhang past the basic string. For bold strings, the 
overhang is the distance by which the overstrike is offset. For italic strings, the overhang is the amount the top of the font is 
sheared past the bottom of the font. 

 Horizontal Aspect (Digitized Aspect X)
Specifies the horizontal aspect of the device for which the font was designed. 

 Vertical Aspect (Digitized Aspect Y)
Specifies the vertical aspect of the device for which the font was designed. The ratio of the tmDigitizedAspectX and 
tmDigitizedAspectY members is the aspect ratio of the device for which the font was designed. 

 First Character
Specifies the value of the first character defined in the font. 

 Last Character
Specifies the value of the last character defined in the font. 

 Default Character
Specifies the value of the character to be substituted for characters that are not in the font. 

 Break Character
Specifies the value of the character to be used to define word breaks for text justification. 

 Size EM
Specifies the size of the em square for the font. This value is in "notional units" (that is, the units for which the font was 
designed). 

 CellHeight
Specifies the height, in notional units, of the font. This value should be compared with the value of the ntmSizeEM member. 

 Avg. Width
Specifies the average width of characters in the font, in notional units. This value should be compared with the value of the 
ntmSizeEM member.



This pictures illustrates some of the font attributes.



Displays the name of the font, including specific attributes, such as italic or bold.



Displays the name of the font family to which this font belongs.



Displays the version number of the font.



Displays the font's copyright information as included by the font manufacturer. Do not assume that missing copyright information 
indicates a public domain font, as it is not uncommon for hackers and font-pirates to remove the copyright information contained in 
commercial fonts.



Displays the font's trademark information set by the font manufacturer.



Closes the dialog box and saves any changes you have made.



Closes the dialog box without saving any changes you have made.



Opens helpfile on the Font Properties page.



Font's name rendered using font itself.




